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1 Safety instructions

Appropriate use

The QuantumX driver for the CANape program may only by used with CANape
in combination with modules of the HBM QuantumX or SomatXR families. Use
for any purpose other than the above is deemed to be non-designated use.

The QuantumX driver provides the QuantumX/SomatXR module functions for
the CANape software. The operating manuals for the modules contain all safety
instructions for operating the modules, the safety instructions for CANape can
be found in the documentation relating to this program. Additional safety meas-
ures are not necessary.
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HBM Markings used

2 Markings used

All trademarks and brands used in this document are trade names and/or
trademarks belonging to the respective product or the manufacturer/owner.
HOTTINGER BALDWIN MESSTECHNIK GMBH does not lay claim to any
other than their own trade names/trademarks.

The markings used in this document

Important instructions for your safety are specifically identified. It is essential to
follow these instructions in order to prevent accidents and damage to property.

Symbol Significance
This marking draws your attention to important in-
formation about the product or about handling the
Important product.
This marking indicates application tips or other in-
. formation that is useful to you.
Tip
This marking draws your attention to information
. about the product or about handling the product.
Information
Emphasis Italics are used to emphasize and highlight text and
See ... identify references to sections, diagrams, or external

documents and files.

Device -> New Bold text indicates menu items, as well as dialog and
window headings in the program environment. Ar-
rows between menu items indicate the sequence in
which the menus and sub-menus are called up

HBM IO.dll This font type indicates file and path names.

Data rate Bold text in italics indicates inputs and input fields in
the user interfaces.

QuantumX CANape A03325_04_X00_00 HBM: public 5
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Terms of license for HBM software

(extract from HBM's General Terms and Conditions)

Special regulations for software

1.

Where the goods or any portion thereof include software that has been de-
veloped by a third party, the extent of the rights and entitlements granted to
the customer is determined in accordance with the terms of license of this
third party, which will be enclosed with our delivery and which will, on re-
quest, be sent in advance. This applies in particular to software such as op-
erating systems and comparable components of the system supplied. We
will provide suitable advance notice to the customer in the event that third-
party software forms part of the delivery, by naming the third-party manufac-
turer in the order documentation, for example.

Where the goods delivered include software developed by us (whether as a
component of the devices or as an independent delivery item), the following
regulations apply:

Permitting the use of the software in return for a one-off payment constitutes
a purchase of rights, unless otherwise agreed in writing for the particular
individual case.

We grant the customer a non-exclusive, transferable right to use the soft-
ware developed by us on a single computer system for an indefinite period
of time. Without written approval to the contrary, the software may only be
used for the customer's own purposes. The software may not be leased,
either expressly or implicitly, without our prior written agreement.

The right of use may be transferred to a third party on condition that the
software be completely deleted from the customer's system and that the
media provided by us, together with all the related documentation, be
handed over to the purchaser.

. Barring a written ruling to the contrary, software installation is the responsib-

ility of the customer.

. The customer is not allowed: a) to pass on the software or associated ma-

terial to third parties or make it accessible to them in any way whatsoever,
without our prior written consent (apart from transferring it in full in accord-
ance with paragraph 2.3), b) to modify the software without our prior written

A03325_04_X00_00 HBM: public QuantumX CANape
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permission, ¢) to compile works derived from the software or to duplicate the
written material or d) to translate or modify it or to compile derivative works

from the written material. The above provisions do not apply where the user
is expressly authorized legally or contractually to carry out specific activities.

We retain all rights to the software compiled by us and to the associated
documents, as well as to any changes we have made. The software and its
associated documentation must be used and stored in such a way as to
keep them reasonably safe from non-contractual use, duplication and shar-
ing.

One copy may be made for backup purposes. Reference to our copyrights
must be included in or attached to the security copy. Should the software
contain a copyright notice and/or a registration number, these must not be
removed.

10.The software is subject to a warranty insofar as the software supplied must

11

essentially perform the main functions and conform to recognized codes of
practice and not contain any errors which could in any way reduce or nullify
its value or fitness for ordinary or contractually prescribed use.

.The software supplied by us — unless otherwise specifically promised — is

not fault-tolerant and was not developed or manufactured for use in inher-
ently dangerous surroundings in which trouble-free operation is mandatory,
such as in nuclear engineering facilities, aircraft navigation or communica-
tion systems, in air traffic control, in machines directly involved in life sup-
port systems or in weaponry, where technology failure can directly result in
death, personal injury or serious damage to property or to the environment.

12.Software error recovery, where this is expected of the customer, will only

take place during product maintenance, as new program versions are made
available in the course of regular product maintenance. To implement the
warranty, the customer is obliged to assist us where feasible in establishing
program errors, by sending error logs and other necessary details on re-
quest. Under no circumstances does the period of warranty begin again
when a new program version is supplied.

13.The general terms and conditions of contract and of our sale and delivery

are also applicable to software, especially regarding warranty and liability.

QuantumX CANape A03325_04_X00_00 HBM: public 7
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4 Introduction

The QuantumX and SomatXR families comprise various modules (MX mod-
ules) to which you can connect a variety of transducers and signal sources:
SGs, SG transducers, current and voltage sources, thermocouples, Pt100, fre-
quency signals, inductive transducers, LVDTs or potentiometric transducers.
The modules can be individually combined and connected via Ethernet inter-
faces according to the measurement task. The distributed operation makes it
possible to position individual modules close to the measuring points, resulting
in short sensor lines.

The differences between QuantumX and SomatXR lie in the application:

¢ QuantumX is suitable for stationary and mobile use. The modules provide
degree of protection IP20, a vibration resistance of 5 g and an impact resist-
ance of 35 g, and can be used in an ambient temperature range of -20 ...
+65°C. You can distribute the modules, clamp them together (CASECLIPS),
or mount them in module racks.

e SomatXR is suitable for use in harsh ambient conditions. The modules have
a sealed housing with degree of protection IP65/IP67, a high impact and
vibration resistance, and an extended temperature range of -40 ... +80°C.
The modules can be connected with (CASELINK) connecting elements.

This manual will support you during the installation of the driver for CANape
and explains how to configure your system of MX modules. Detailed
information about connecting and configuring the MX modules can be found in
the QuantumX/SomatXR operating manuals and in the MX Assistant online
help.

The QuantumX/SomatXR documentation includes:

QuantumX/SomatXR operating manual with pin assignments

Data sheets for the MX modules

Online help in the programs
- MX Assistant

- Sensor database

- TEDS Editor

8 A03325_04_X00_00 HBM: public QuantumX CANape



HBM Introduction

4.1 Scope of supply
¢ QuantumX/SomatXR system CD

e This operating manual

4.2 System requirements

e CANape Version 10.0 or higher (XCP driver), we recommend using
CANape Version 13.0 or higher

¢ Ethernet interface

QuantumX CANape A03325_04_X00_00 HBM: public 9
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4.3 Supported modules, restrictions

The following MX modules are supported, provided you use firmware version
4.0.34 or later:

MX403B,

MX410, MX410B,

MX440A, MX440B,

MX460, MX460B, MX460B-R,
MX809B,

MX840, MX840A, MX840B, MX840B-R, a CAN bus on channel 1 is not sup-
ported, however.

MX878, MX878B,

MX879, MX879B,

MX1601, MX1601B, MX1601B-R,
MX1609, MX1609KB-R,
MX1615, MX1615B, MX1615B-R.

Additional modules can be supported on request.

The driver supports a total sampling rate (all modules) of up to 3.2 Msamples
per second.

10
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5 Installation

Important

From Version 4.0, the MX Assistant can only connect with MX modules using
firmware version 4.0 or higher. Newer QuantumX modules (B functionality) and
SomatXR modules are delivered with firmware 4.0 or higher. You can only dis-
play QuantumX modules with older (prior to 4.0) firmware (Old modules tab in
the Scan dialog), it is not possible to connect.

Also see Section 8, Updating the firmware, Page 45.

Information

Administrator rights are required for the installations. We recommend that you
close all open programs.

Requirements

For installation, you need the system CD for QuantumX/SomatXR and the
QuantumX CANape Driver Setup program. The program can be downloaded
from the HBM website, or via the Start window of the system CD and the
Driver button.

Procedure

Place the system CD for QuantumX/SomatXR into your drive. In the standard
configuration, Windows automatically opens the CD and displays the Start win-
dow, in which you select the language for the version of the MX Assistant you
want to install.

Should you have deactivated the Windows Autostart function or have received
the installation file via a download, find the start.exe file (root directory of
the CD or download) and double-click on the associated icon to obtain the Start
window.

Select the language in which the software should be installed on the Start
screen. If you have not already done so, download the QuantumX CANape
Driver Setup program from the HBM website: Click on Driver.

QuantumX CANape A03325_04_X00_00 HBM: public 11
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Then, in the Start screen, click on Device Assistant, Tools, etc., followed by
Next. Read the licensing agreements and specify the directory in which the
software is to be installed: Confirm the proposed target directory or click on
Browse to select the directory you require. If necessary, the setup program will
create the directory you have defined.

Programs to be installed
The following program must be installed as the first step:
* MX Assistant 4

You must also install the FireWire driver for a PC if you want to connect the MX
modules via FireWire.

Also install the QuantumX Firmware Updater program if you have MX modules
with firmware version 1.x or 2.x.

As a second step, after installing CANape, you must install the HBM driver for
CANape:

e Unpack the downloaded file and start the QuantumX CANape Driver
Setup.exe program.

Select the language in which the software should be installed, and follow the
instructions in the installation program.

Important

Installation of the CANape driver enables the installation of an NTP time server
(Full installation). This installation is only necessary during the initial installa-
tion of the CANape driver. You can suppress the re-installation of the NTP time
server during an update.

NTP time server: The NTP time server from Meinberg must be installed for the
synchronization of all devices participating in the measurement. It is not neces-
sary to synchronize the time server with an NTP time server on the Internet and
this is not set up by the automatic installation.

You can change the configuration of the NTP time server later on, also see
http://www.meinberg.de and Section 7.4 on Page 26.

12 A03325_04_X00_00 HBM: public QuantumX CANape



HBM Installation

Before installation, a summary of all components to be installed is displayed;
confirm this selection with Install. The setup program installs the

DaIo HBM QuantumX Driver.dll driverin the \Exec subdirectory of the
CANape installation directory.

QuantumX CANape A03325_04_X00_00 HBM: public 13
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6 Setting up the MX system in CANape

The following examples and figures were generated with CANape 13.0. In older
versions of CANape, the procedure is slightly more complicated, as the file for
the HBM device driver has to be explicitly specified, but the principle is similar.

You must set up the devices used once for each project in CANape. The MX
modules are specified here and the driver for CANape is integrated. The HBM
driver for CANape is then loaded again when this project is opened. The config-
uration of the device is independent of this and is described in Section 7, Page
16.

1. Start CANape and create a new project.

2. Then select Device -> New.

e \ectar CAMape

File Edit Display Measurement  Calibration  Analysis
1 ._..'; I.H Lﬂ __I Tewy...

1 (Mew) Mewy from »
Symbal Explarer Configuration...

__]AII— Database b
E Wector hardware configuration..,

E Explorer Sen Wector WX configuration..,

Fig. 6.1 Creating a new device

3. In the next dialog, enter a Name for the device type and select QuantumX
as the device (Fig. 6.2). You also have the option to enter comments for the
device type.

14 A03325_04_X00_00 HBM: public QuantumX CANape



HBM Setting up the MX system in CANape
ﬁ Meww Device @
Mame: Quantums
Comment:
ECU CCP HCP V1000 Diagnastic oDl
Fremm e T | ’ Simulink Simulink. Kw/P2000 KW /P2000 RamScope
R TR DLL XCP Server | | on CAN an KeLine
nterface
Manitar CAN ETH FlexRay LIN MOST
b
0 Vector 0 HI-DAQm GPS Audio DAIOSystem
& WS B SMB Signal Quanturmi
generator
Multimedia Camera ar AVB
File:
Other HexE dit CaMreplay CaN CAMopen
extender
[ QK ] [ Cancel ] [ Help

Fig. 6.2

Selecting QuantumX as the device

4. Close the dialog by clicking on OK.

The driver for the MX modules is now available for this project. In order to work
with one or more modules, you must configure the module(s), i.e. specify the
connected sensors and signals, define outputs and output according to the ap-
plication case, etc., see Section 7. The MX Assistant is called immediately after
closing the dialog, so that the settings can be made. Please also note Section
7.4, Page 26, regarding the synchronization of the MX modules.

QuantumX CANape
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Configuring QuantumX/SomatXR

7 Configuring QuantumX/SomatXR

7.1 Connecting with the MX module(s) for the first time

After activating the driver for the MX modules as described in Section 6, the MX
Assistant is called without having to find devices. Re-close the Assistant and
call it up via the Device menu, as otherwise the configuration generated by the
Assistant cannot be accepted in CANape.

1. Select Device -> Configuration in CANape.

2= Vector CANape
File Edit Display Measurement  Calibration  Analysis
NEHA __I Mew...
1 (Mewd Mean frarn 4
Symbol Explarer Configuration...
3 Al Database »
@ Wector hardware configuration..
E Explorer Sed Wector WX configuration...

Fig. 7.1 Calling the configuration dialog

2. In the dialog that follows, click on the QuantumX entry or on the name you
gave to the device type when setting up the MX system in CANape (Section
6, Fig. 6.2, Page 15).

3. The button to start the MX Assistant will then be displayed on the right side
of the dialog. Click on Edit to call up the MX Assistant, which is used to fur-
ther configure the settings.

16 A03325_04_X00_00 HBM: public QuantumX CANape



HBM Configuring QuantumX/SomatXR

T Device Canfiguration @
Device  Metwork  Calibration  Flash  Database 7

| % % | eZ eF g v o2 | om o & % | @ | @ & 7

a [®] Devices Quantum

a A Quantum [Quantumi driver for I0-Interface]
A% Device Thesaurus

Metworks Comment:

Chanrels

—D e
v Wectar Settings: Edit
Vo, Wectar

M, Wector YNBA0D
B Gateway

%™ BusDoctar
Bl EthRouter

Device settings o

]

=
(=

m

Fig. 7.2 Starting the MX Assistant via CANape

4. Click on P?_L (Search) in the Quick Access Toolbar, to find the connected MX
modules.

The search for modules dialog (Fig. 7.3, Page 18) is displayed.

5. Search for your modules in the network: Browse the network(s) and se-
lect from the result.

Browsing covers both the Ethernet interface(s) and the FireWire interface —
if present. The modules found are displayed in the list and can be selected.

QuantumX CANape A03325_04_X00_00 HBM: public 17
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*'El Search for modules = 3
Options
Select the modules to appesar in the Assistant.
\nfith Ethernet, only modules with the same subnet mask as your PC may be connected.
Modules not accessible are grayed out Change the IP settings of theze when they are
| supported by the assistant
() Search the nebwark[z) and uze all modules found

() Use modules from specific IF range only (e.q. 192.168.163,30-70) Connect directly
() Use modules with specific UUID : anly [e.q. SES0008BA or BBA:ED 2]

@ Search the nebwork(s) and select from the result

z—[Found mucuesl Stored module list | 1P list from file [connect directly) | 0ld modules ]—

Name a Type  Seral /UUID Address Subnet mask  Firmware version
MX410 MX410 001234 192.168.100.125 2552552550 42100
MXB40D MXB40 001533 192.168.100.126 2552552550 4.2.10.0
MXB79 MXB7% 0035C5 192.168.100.127 2552552550 42100
fl Fescan network(z) [F5) ﬁ Edit netwark. gettings - Flazh module LED =
@) Help [u] Cancel

Fig. 7.3  The search for modules dialog

6. Select the module(s) to be operated with CANape.

If the modules are not in the same Ethernet segment, no connection can be

made. In this case, assign different Ethernet addresses via Edit network
settings.

7. Click on OK.

The MX Assistant connects to the selected module(s) and displays the
channel assignment (also see Fig. 7.9, Page 23).

18 A03325_04_X00_00 HBM: public QuantumX CANape



HBM Configuring QuantumX/SomatXR

As soon as you close the MX Assistant after configuration, you will be asked if
the file containing the description of all the settings should be saved (Fig. 7.7).

Save 2

. = Do you want to save the module settings in the file
W Ch zershPublichD ocumentsiwWector CAMape 145N ewProjectyiissiztant5 ettingsF orCaM ape.wml'?

Fig. 7.4  Saving the MX module settings

Click on Yes for the file to be saved (in XML format). The information relevant
to CANape in this description file is then transmitted to CANape by the HBM
driver. The description file is saved together with the CANape project and
loaded into the connected MX modules when the project is opened, so that the
same settings are present as in the original configuration. If you want to imple-
ment any changes to the configuration of an MX module, you must call the MX
Assistant again as described above, to create a new description file and then
accept the file again in CANape.

Important

For it to function correctly, you also have to set up time synchronization, see
Section 7.4, Page 26.

7.2 Calling up the configuration in CANape

In order to carry out measurements with an MX module, you must configure the
module for the sensors or signals used. Once an MX module is set up in
CANape, the settings can be implemented with the MX Assistant in the
CANape program. Do not call up the Assistant via Windows to configure a
module, as the information required by CANape will only be generated when
the MX Assistant is closed after having been opened via CANape. When a pro-
ject is opened, the configuration saved in CANape should be loaded into the
module again so that CANape has the latest version available. Any changes
that you have made in the meantime will however be lost.

1. Select Device -> Configuration in CANape (Fig. 7.5).

QuantumX CANape A03325_04_X00_00 HBM: public 19
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Configuring QuantumX/SomatXR

2 Vector CANape
File Edit Display Measurernent  Calibration  &nalysis
NEEHE ! O Mew..
1t (Mews) e frarm 3
Symbol Explorer Configuration...
3 Al Database 3
E Wector hardware configuration..,
B Explorer cen Wectar Wi configuration..,

Fig. 7.5  Calling the configuration dialog

2. In the dialog that follows, click on the QuantumX entry or on the name you
gave to the device type when setting up the MX system in CANape (Section
6, Fig. 6.2, Page 15).

3. The button to start the MX Assistant will then be displayed on the right side
of the dialog. Click on Edit to call up the MX Assistant, which is used to fur-
ther configure the settings. Explanations of the settings and a description of
the MX Assistant can be found in Section 7.3, Page 22.

T2 Device Configuration @
Device Metwork Calibration  Flash  Database 7
W% % 2 eE BB R |m/ & O | % |0 @B EE
4 [®] Devices QuantumX,
a A Quanturncd [Quanturn driver for I0-Interface] Device settings il

A4 Device Thesaurus
Metworks Caomment:
Channels
FD Vector Settings: Edit
Ea\f'ector\p")(
M, Wector WNBIOD
B Gateway
W BusDoctor
Bl EthRouter

=
(=

4

m

Fig. 7.6  Starting the MX Assistant via CANape

20 A03325_04_X00_00 HBM: public QuantumX CANape



HBM Configuring QuantumX/SomatXR

As soon as you close the MX Assistant after configuration, you will be asked if
the file containing the description of all the settings should be saved (Fig. 7.7).

Save 2

. = Do you want to save the module settings in the file
W Ch zershPublichD ocumentsiwWector CAMape 145N ewProjectyiissiztant5 ettingsF orCaM ape.wml'?

Fig. 7.7 Saving the MX module settings

Click on Yes for the file to be saved (in XML format). The information relevant
to CANape in this description file is then transmitted to CANape by the HBM
driver. The description file is saved together with the CANape project and
loaded into the connected MX modules when the project is opened, so that the
same settings are present as in the original configuration. If you want to imple-
ment any changes to the configuration of an MX module, you must call the MX
Assistant again as described above, to create a new description file and then
accept the file again in CANape.

The existing channels, i.e. all channels with channel names, are displayed in
CANape both in Explorer and in the database editor (Fig. 7.8). Channels
without channel names, shown in the default setting of the MX Assistant as
"Unknown", do not appear in CANape (option Show blank channel and signal
names as 'Unknown’). Should duplicate channel names be assigned, only the
first channel of this name will be displayed. This is why the Check for duplic-
ate channel names at end of program option is active in the MX Assistant
default setting, and you can correct duplicate names. The main channel set-
tings are visible in CANape as comments.

QuantumX CANape A03325_04_X00_00 HBM: public 21
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Eﬁ Database Editor

File Edit ‘“iew Tools 7

P = & BAQ
Quanturmi Content of: “W3840_1533"

4 |_'3-‘ Quarturmi Type  Marme 4 Address Base data ty... Cormment
hAx410_1234 2 DC_1my 0010 DOUBLE Sensoroltage; Filter:Lowpass,Bessel 100Hz
hAX840_1533 123 Displacement nona DOUEBLE SensorlndBridge; Filker:Lowpass,Bessel 100
hAXBTA_35C5 2 Farce 0018 DOUBLE Sensor:Bridge; Filter:Lowwpass,Bessel 100Hz
Frames b2 Z6 oo DOUEBLE SensorBridge; FilterLowpass,Bessel 100Hz

Correersion rules
Mumeric and text tables
Record layouts

Wariant criterion
Systern constants

WEFWEELDLULUL

Memory segrments
[ IF_DATA infarmation

&4 Search result

[ User-defined filters

Fig. 7.8  List of active channels in the CANape database editor

You can change the device names (e.g. TID001 in Fig. 7.8) in the MX Assistant
via the context menu for the device (Modules window). However, the change is
only adopted in a new CANape project. The name is supplemented by the sig-
nificant figures of the UUID (Universally Unique Identifier, identical with the
serial number and MAC address) for CANape.

7.3 MX Assistant

The MX Assistant supports you in configuring the MX modules and offers you
the possibility of observing the acquired signals. Modules that have calculation
functions, or which can output signals, can also be configured in the MX Assist-
ant.

Information

In the default setting, the functions of tabs in the Ribbon that are not supported
by the active (marked) module are not accessible (gray). Groups or component
tabs that are not accessible are usually completely hidden.
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File and system menu

. Ribbon
/chk Access Toolbar
[ =l - @ MX Assistant V4.2 R1§218) o @ 52
i Signals Functicns Outputs Digital '0s Scope Sensor databifie & Showlog

n
Serial / UUID | Sync. type Path Type Signal name| Sensor descrip T Amplifier setting Outpu #09. Signal value =
i i 115 MXAT0 (001234) AN 5 Y Voltage: 10V [~]
@ M v | 001234 L 1 M1 (O 234) AN TV yakage: 10Y
;@ M MxBA0 001533 At 1: X410 (Q01234) AN 5V atage: 10V
@ M 1067 | 003 lls 12 X410 [001234) AN T V. Volage; 10
Sensor DE L 1.1: MxB40(001533) AIN Z6 26 50ka 105 €53 Full bridge; 480.
Search Test y 21 MxB340(0M533] AN Displacement Displacement 1@{} Inductive Full b.
1+ M40 (O01533) AN DCA0V D vobage 108185 V. Voltage: 10V
[ Databases 4.1: M<840(001533) AN Force Farce T &% Full bridge; 480
(3 CAN databases (not editable) 5.1 : MxB40 [0M533] AN 8 Y Vohage; 10V £
B 9;5"5" sensordatabase (notediadle) W 1 yeaan (001533) AN HighVoltage: DI voltags 603195 . vakage: 50V
-4 Sensor groups
) [ User ssnsar datsbasss (sditabls) s Tl vokage: 10
26 Sensors.sdb 1+ MXB40 (001533 AN 5 ¥ Volage; 10V
[=- 3 Sensor groups
5 Lot
&5 Displacement
2 Force
5 IEPE
4 Search results
: |
Sensor databases Channel list

Fig. 7.9  MX Assistant main window, tab Channels
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Senzar DB 2

Ceanch Text e — Input field for searching for sensors

(enter name/designation)

Databazes
: D CAM databazes (not editable)
[:j HER zenzor databasze (hot editable)
+':|_| Sensor groups
= [:j Uszer zensor databaszes (editable) e
—[j Senzors.xdb
—“_-u Sensor groups

w45 LvDT

+':|j Displacernent

+t|] Force

45 IEPE
----- ':8 Search results

Sensor database (write-protected) with
HBM sensors and general sensors
(voltage, current, thermocouples, etc.)

\ User database for your own sensors

Fig. 7.10 Component window Senso

As the HBM sensor database only

r database

contains general data for the various

sensors, you should set up your own sensor database (user database) with the
data from the calibration logs of your sensors, if you do not use TEDS sensors,

see Section 7.7, Page 32.

If you do not use TEDS sensors nor want to set up your own sensor database,

you will have to re-enter or re-calib

rate the particular data for the connected

sensor after every change or connection to a different channel (Amplifier set-
tings column, Fig. 7.11, ), as the information in the MX module is only ever
saved for the actual channel (also refer to Section 7.7).
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Path Type Signal name| Sensor descrip TS Arnplifier zetting Olutpu) se% Signal value

1.1 M=840 (001533) AN Z6 ZE Blkg e {} Full bridge; 480... ... kg z
21 Mx840 [001533) AW Displacement Displacement 751!]5. {} Inductive Full b... == | |
31 M=B40 [001533] AdW DO DC valtage T0MTES M Voltage: 10V W =
4.1 MxB840 [001533) AN Farce Force TQ.E @ Ful bridge; 480... « N ?
B.1: Mx240[001633] AN e M olage: 10V W =
E.1: M=840 (00533) AN HighVolkage DC voltage BDVIES M volkage; B0V v W =
7.1 Mx340[001533) AN e M olage: 10V Y B
8.1 M=840 [001533] AN e M olage: 10V v W =
! Pl IS

1. Shows the channel and the subchannel number. Subchannel numbers are not present
in the modules used here.

Channel type.

(SN

Signal name (channel name). The name does not have to be the same as the sensor
designation.

Shows the presence and use of TEDS sensors
Symbol for the sensor type
Description of the amplifier input setting

Calls the TEDS Editor if TEDS sensors are present, otherwise the dialog is called to set
the data for the amplifier input (sensor type, excitation voltage, scaling, etc.).

8. Currently set output unit (from TEDS, sensor database or manual). You can convert the
sensor unit using the arrow on the right in this field, e.g. from N to kN.

9. Indicates whether a zero balance has been carried out and that the zero value is
subtracted from the current measured value. If necessary, change the zero value using
Edit in the Zero group.

No o b~

10. Displays the measured value and whether the sensor is correctly connected.

Fig. 7.11  The channel list and significance of individual columns

Procedure for configuring an MX module

1. Connect your transducers or signal sources.
The connection plans can be found in the operating manual for the MX mod-
ule.

2. Connect your PC with the module(s) to be operated with CANape.

[¢)]
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3. Specify an NTP time source for the MX modules.
This setting must only be carried out once for each MX module, see Section
7.4, Page 26.

4. Configure the measuring chains via TEDS or with the sensor database.

5. Assign unique signal and channel names (these names are required by
CANape and are displayed as signal sources).

Optional settings

1. Specify the filter settings.

2. Perform a zero balance.

3. Add your own transducers or signals (user database).

4. Have the measured values displayed graphically (Scope).
5

. Define functions such as peak value detection, calculation of the RMS
value, or limit switches, if you have the corresponding modules.

6. Specify the digital I/Os or output signals, if you have the corresponding
modules, see Section 7.12, Page 41.

7.4 Specifying the NTP time server (synchronization)

In principle, the time information can be made available via various sources in
the MX modules. The version to be used is dependent on your device configur-
ation:

1. You are using just one MX module via Ethernet
Use the time server installed on your PC and enter the IP address of the PC
for the MX module.

2. You are using several MX modules, including some connected via FireWire
Use the time server installed on your PC and enter its IP address in the MX
module with the highest UUID (serial number). Set all the other modules to
Auto. It is also sufficient if you only connect the MX module with the highest
UUID via Ethernet.

3. You are using several MX modules that are only connected via Ethernet
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Use the time server installed on your PC and enter its IP address in the MX

module with the highest UUID (serial number). Set all the other modules to
Auto.

The NTP time server can also be installed when installing the HBM software.
The PC is set here as the time source for the NTP time server. We recommend
that you do not install the time server in the network, as the different runtimes
could result in too great a time difference between the PC and the modules. If
this is the case, CANape will not perform a measurement.

Procedure

1. In the MX Assistant component window Modules, right-click on the module
with the highest UUID and select Edit time source (Fig. 7.12).

Modules
Name Serial / UUID  Sync. type

- @ IS MX410 001234 Aute

b @ 2 MX240 001533 Aute

----- @ D= MXB79  0035C5 Lute
METI

Feload module settingz

A
E7 Load..
=l
Q

Save..
Q" Flash module LEDs...
A] Rename..
IP Mx879, 192.168.100127

& Edittime source...

Fig. 7.12 Modules component window with the context menu for a module

2. Select NTP in Active time source type (Fig. 7.13).

3. Enter the IP address of your PC or the time server in the network for IP ad-
dress.

4. Set the synchronicity threshold to a value that can still be tolerated as a time
delay, e.g. 10,000 ps.
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If the time delay of the module is greater than the time set here, no meas-
urements will be possible. Do not enter a value that is unrealistic, otherwise
measurements will be stopped.

{? Edittime source »0009E50035C5« = =z

Edit the time source of module MXE79 (D009ES0035CK).

8: Expand all  Collapze all
Aclive ime source ype NTP EI
4 Time source sethings
IP address 192.168.100.19

Threshold 'out of sync' in ps 10000

Active time source type
Active lype of the ime source settings.

@) Help (] 8 Cancel

Fig. 7.13 Dialog Edit time source

5. Click on OK.

6. If necessary, repeat the process for the other MX modules, to set them to
the Auto time source type. The system is not able to measure with any
other settings.

Possible settings for the time source type

Auto: Uses the internal time source of the module or synchronizes with the
master module or CX27, if present and connected via FireWire. The master
module is the module with the highest UUID (serial number).

NTP: Enables synchronization via Ethernet. The module obtains the actual time
from this time server, taking into account the runtime of the signal. The achiev-
able minimum synchronization deviations are approx. 100 us.
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Important

After the time source has been set to NTP, the relevant module must be restar-
ted. The process requires up to two hours after the initial activation to reach the
steady state. Leave the module switched on after activation until the module
LED lights up green (the LED lights up orange during the process or when the
set synchronicity threshold is exceeded). This process usually only takes two
minutes after the next start-up.

EtherCAT (with CX27 module only): This version is currently not supported in
combination with CANape.

IRIG: This version is currently not supported in combination with CANape.

Information

The MX module filters have a runtime (phase delay) and can therefore affect
the synchronicity of the measured values if you select different filters in the indi-
vidual channels.

7.5 Re-connecting with the MX module

Once you have set up a connection with an MX module and saved the settings
in CANape, the MX Assistant is called up the next time the MX configuration is
started, and the connection with the previously connected device(s) is restored.
If the module settings were changed, the settings saved in the description file
can be re-transmitted to the MX module: In the dialog, displayed when the As-
sistant is started via CANape, drag the corresponding settings file on the left
side to the MX module on the right side.
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Load module settings =] foxcs

Dra

10

drop it onto the table row with the meodule on the night-hand
ules (the lock symbel indicates modules excluded from loading

g a setting from the liston the lefi-hand s1
he table contains all currenthy connecte:
settings inta).

Click into the table row with the respective module and press Delete to remove an assignment.

Lwailzble settings = Module Setting to use -+ 1R
M40 (001 234) W34 10 (001234) WM3410 (001234)
M40 [001533) M40 (001533 M340 [001533)
ME79 [0035CE)
M579 [0035C5) WME73 [0035CE)
ok LCancel

CilsersiPublictDocumentsi\Wector CANape 134N ewProjecth QA sistantSettingsForCAMape xml

Fig. 7.14  Start dialog the next time the MX Assistant is called

This sets up the MX module with the same settings saved in the description file.

7.6 Configuring a channel via TEDS transducer
identification

In the Channels tab, mark the channel to which the TEDS sensor is connected,
and select Use TEDS, if available or TEDS required (Fig. 7.15). In the latter
case, an error message will appear if no TEDS is found. Various symbols are

displayed in the column with the TEDS icon (), depending on whether TEDS
transducer identification has been found, and which setting you chose:

% TEDS found, setting Use TEDS, if available.

5 No TEDS found, setting Use TEDS, if available.

i TEDS settings invalid or new (empty) TEDS module.

E5 TEDS found, setting TEDS required.

T—Ea':‘i No TEDS found, setting TEDS required.

30 A03325_04_X00_00 HBM: public QuantumX CANape



HBM Configuring QuantumX/SomatXR

we | D) ol - @ @
Fil= Channels Signals Functions Outputs
T@E E.i'«captati:-r {
Details | TEDS ~ #] Edit Opt
lgnore TEDS
Modules | 1es  |Jse TEDS f available
Name |1 TEDS required

.....

Fig. 7.15 Activating TEDS use

Configuring a new (empty) TEDS module

You can only ever record one channel or one sensor, multiple selections are
not possible. The sensor's TEDS module must have been detected, otherwise
the TEDS module will not be recorded. Use, for example, the setting Use
TEDS, if available (Channels tab, Sensor group).

1. Create the sensor with its data in the sensor database, as usual, see Sec-
tion 7.7.

2. In the Channels tab, drag the sensor from the Sensor database compon-
ent window to the channel to which the sensor with the TEDS module is
connected.

3. In the next dialog, confirm that you are applying the sensor designation as
the channel name, enter a different channel name, or leave the field in the
dialog empty or delete it so that no channel name is saved in TEDS.

Data already present in TEDS are deleted and the data from the sensor
database are applied — as far as possible — in the TEDS module. Be aware
of the possibility that not all the entries in the sensor database can be writ-
ten to the TEDS module, as the TEDS standard has size restrictions for
various fields. Fields certainly also exist in the TEDS module that are not
available in the sensor database, such as the "Response Time" of a sensor.
Such fields are, however, not relevant for QuantumX/SomatXR modules.
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With MX1609 and RFID modules, the connectors to the left and right of the
RFID module to be programmed must not be assigned (no RFID module/
plug connected).

4. Confirm with Yes that the current TEDS content is to be overwritten.

Information

If a polynomial scaling is stored in TEDS, just one section is supported by the
QuantumX/SomatXR modules, as the TEDS standard only allows for one sec-
tion. You must delete any other sections that may be present in the sensor
database before assignment, as they cannot be transmitted to the TEDS mod-
ule.

7.7 Creating a user-specific sensor database

The sensor database is used to set the measuring chain to the sensor being
used, if you are not using sensors with TEDS. You only need to enter the char-
acteristic values of a sensor once, you can then assign the sensor by mouse-
click or Drag & Drop to the channel it is connected to. The measuring amplifier
is then set to the characteristic values of this transducer so that the measured
value is correctly scaled and displayed with the unit of the measured physical
parameter.

Fig. 7.16 shows the entry for a force sensor as an example. Enter a name in
the Designation line with which you can uniquely identify the sensor, e.g. in-
cluding the serial number. The additional details relate to the type of connec-
tion (bridge type: full bridge), the circuit type (6-wire), and the required or
allowed excitation voltage for the sensor. Depending on the options of the MX
module used, the next-smallest available excitation voltage is set.
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we |y - @ 9 MX Assistant V4.2 R1(218) = @ =%
Fll= Channels Signals Functions Outputs Digital 110s Scope Sensor database & Show log
LG I & & Bk & UXH 09
MNew Add Remove Saveas Cul‘t' Add Add = Delete Cut Copy | Info | Help
User sensor datsbase CAN da Group Sensor Clipboard Infa | Help
Search Text

EG Databases

: [3 CAM databaszes (not editable)

[3 HEM sensar database inot editable)
BG User sensor databases (editable)

Al | Expand all

tanufacturer

tdodel

teazurement location 1D
Calibration date

Description

COB 5kN #12744

BG Sensors.sdb Initialz of calibrator [N
Bﬂ_‘ﬂ Sensor Jroups, Calibration period 1] |
15 LVDT Cornrnent |
-3 Displasement Drescription file |
. 4 Senszor
Active senzor type Bridge |
£l IEPE 4 Settings |
@ Search rezults Bridge type Full bridge |
Circuit type B-Wire |
Excitation in'y 25 |
Cartier frequency Auto |_.=
Impedance in 350 1
helax. electr. output in mih 2 0152
Electrical unit ot |
4 Scaling |
Active scaling type Zero-Span |
4 Settings { Click here for an extended editor -> ) |
Electrical zera 1] |
Electrical span 2.0152 |
Phyzical zpan 100 |
Fhysical unit KN |
Physical unit {user) LN
Supply voltage 1} B

User defined description. This text iz displaved as databaze entry

)
Fig. 7.16 Tab Sensor database

Scaling depends on the data listed in the calibration certificate of the sensor; in
Fig. 7.16, this is 2.0152 mV/V (Electrical span) for the maximum capacity of
100 kN (Physical span). Calibration in the sensor database is not possible, but
Section 7.8 describes the procedure if you want to calibrate a sensor when in-
stalled.
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Tip

Call the special help for the sensor database via Help (Help group) in the Rib-
bon. There are numerous examples here for various sensor types and detailed
explanations for the individual input fields, as well as the procedure for setting
up your own sensor entries.

I
[u]
<

7.8 Configuring a channel via the sensor database

Drag the sensor from the sensor database component window to the channel
(line in the channel list) it is connected to.

The channel is then configured, in general you only need to perform a zero bal-
ance (see Section 7.9, Page 36).

Manually modifying/calibrating the sensor scaling

If you do not want to store the sensor scaling permanently in the sensor data-
base, but recalibrate it for each application, just enter the sensor initially with
the "general" values. Assign it to the channel it is connected to in the normal
way. Then, in the Amplifier settings column, double-click on the channel and,
in the next dialog, click on the right side of the Settings line and on the arrow
facing down. This opens the Sensor adaptation dialog (Fig. 7.17).

Enter the values for two points on the characteristic curve that you can imple-
ment as a load on the sensor (Physical y1 and y2), and measure the corres-

ponding electrical values (Electrical x1 and x2). To do this, click on \ZI The
values for O N (no load) and 3000 N load were measured in the example below.
The entire measuring range of the sensor (physical span) is 5000 N.
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£ B =

Edit sensor adaptation, e.g. the scaling, for this channel only.

se the sensor database if you want to change the scaling type or other sensor parameters.
Electrica values may be measured.

gg;l =] Espandal  Collapse al

Zero-Span
[ Click here for an extended editor -> ] E

Enter bwo points for the calculation of the Zero-Span zcaling,
The electrical walues may be measured.

Y Physical Electical
»2 W0 41 010407463468709
" # y2 3000 x2 [131193043783920
£
1 -
W el span Physical span 5000
0k ][ Cancel ]
Seltings
Scaling settings

@) Help Update in databaze ok Lancel

Fig. 7.17 Dialog Sensor adaptation

Information

All changes to the channel settings are noted in the log. You can call up the log
via Show log, on the top right above the Ribbon.
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7.9 Performing a zero balance

In the Channels tab, mark the channels to be set to zero and then click on
Zero in the Zero group.

In order to delete a zero value again, click on Clear in the Zero group.

7.10 Setting the data rates and filters

Important

All modules must use the same sample rate domain (classic or decimal).

Call up the Signals tab. In the default setting, just one signal per channel is
displayed (Options -> Hide all signals 2 in the Signals group), as CANape
can only process one signal per channel.

Double-click in the relevant channel on the entry in the Filter @ Data rate
column to display the configuration dialog (Fig. 7.18).

In this dialog, select the Filter type, the Filter characteristic, the Filter fre-
quency and the required Output rate.

Copy the settings (Copy in the Signals group or Ctrl-C) to transfer them to fur-
ther channels. Mark the channels that should have the same setting and then
click on Paste in the Signals group or use Ctrl-V.
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@ Signal adaptation»001533.4.1.1: Force= =] focs
Edit signal seliings.
e | =] Espandal  Collapse al
Signal number 1}
Signal name Force
Qrigin of name TEDS
a4 Filter
Active filker type Lowpass
4 Seftings
Filer charactenstic IIR Bessel
Filter frequency in Hz 0
Olutput rate in Hz 300
4  [utput settings
Description analog input: connector 4, zignal 1
Signal reference Analogln_Connectard. Signall
Dl available Tes
|zochronous data transfer Off
Murnber of post decimal places 4
Signal format 32-bit real
Signal name
Signal name
@) Help k. LCancel

Fig. 7.18 Dialog Signal adaptation

Information

The Number of decimal places is determined solely by the number displayed
in the MX Assistant. The measured values are transmitted to CANape with full

resolution.

QuantumX CANape
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7.11 Digital inputs/outputs

Important

To process the values of other modules, the MX modules must be connected
via FireWire. In addition, Isochronous data transfer must be activated for all
signals that are to be used as a source signal for another module (Signals or
Functions tab). This activates the data exchange between the various mod-
ules and ensures that the values concerned are transmitted via FireWire so
that they are available to the other modules (isochronous signals are displayed
in bold text in the Sources component window).

You must only use the MX Assistant to configure which module signals are to
be output at which output of a different module. But you can also trigger the
outputs via CANape.

Click on the Digital 1/0s tab to see the digital inputs and outputs. You can use
the tab in the window to restrict the view to inputs or outputs.

Only inputs are specified in the default setting. If you need the outputs, this
must be set via the context menu in the Type column (Fig. 7.19).

DI11: Mxg73[0035C5)  [DIN_1hA7a clnital_in 008
DL12: MX873(0035C5]  DAN T Lin_007
DL13:MX873(0035C5) DN fp Output  in D08
DI14: MXBFI(003BCS] DN MxB79_digial_in_D03

Fig. 7.19  Specifying the digital output

To assign an (isochronous) signal to an output, drag the relevant signal from
the Sources component window to the relevant output channel (Fig. 7.20).
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DI1B: MB79[003505] DM Not inverled - BN -
—

)
Fig. 7.20 Applying signals to digital outputs

Both the analog and digital outputs are identified by the icon [ in CANape.

Analog and digital inputs are identified by the icon <. In CANape, you can use
digital inputs as analog inputs, the value range is simply always 0 or 1.

Setting digital outputs via CANape

There are two ways to set a digital output via CANape: manually or by script.
To set the output manually, create a calibration window (Fig. 7.21).
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Fig. 7.21 Outputting digital signals

;r\u‘ector CAMNape
File  Edit Device  Measurernent  Calibration  Analysis Flash  Tools Window ¢
RE=1" Measurement windows v 1 @ B e t o P L
’m Calibration windous 3 Calibration windo
Symbol Ex Diagnostic windones 4 Group Calibration window
£ Al Other windous [J Pararneter Explorer
@ Iyrbol Explorer Ctrl + EINGARE taps Curve window

In the dialog, select the relevant output and click on Apply (Fig. 7.22).

[l_ﬂ Database Selection

Quantumi
4 |_'3-, Quantumi
| MAX410_1234
| hAxE40_1533
[ MAXATI_35CS
| Frarmes

&4 Search result
[ User-defined filters

N EE | &RQ | & | « Apply

= -5 ws]

Content oft "hXETI_35CT
Type  Marne * Unit Comrment
0— A Qutl Y

Diglnl

Digln2
0—  DigQutl
o DigQut2

5 Objectis) found, 1 Object(s) selected

Fig. 7.22  Specifying outputs for signal output

A window then appears, in which you can specify the output value (Fig. 7.23),
either by directly entering a value or by using the buttons on the top left of the

window.
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Fig. 7.23 Manually specifying the output value

7.12 The functions and outputs tabs

Important

To process the values of other modules, the MX modules must be connected
via FireWire. In addition, Isochronous data transfer must be activated for all
signals that are to be used as a source signal for another module (Signals or
Functions tab). This activates the data exchange between the various mod-
ules and ensures that the values concerned are transmitted via FireWire so
that they are available to the other modules (isochronous signals are displayed
in bold text in the Sources component window).

Functions

The Functions tab allows you to configure peak value detection, limit value
functions or mathematics functions, e.g. RMS value or torsional vibration detec-
tion, in those modules that support these functions. Where required, activate
the function channels display for the relevant module via the Modules compon-
ent window (click on the module or on Computer). Depending on the module,
you have to activate the required function via the Active column and the con-
text menu, in order to specify the function via the Signal settings column.

Mathematics and peak value functions can also be output via analog outputs,
see next paragraph. Limit value functions can be output via digital outputs, for
example, see Section 7.11, Page 38.
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Outputs

The Outputs tab allows you to configure the signals to be output for modules
that can output the signals from other modules. In the window, click on the
Analog outputs tab to configure the signals. Alternatively, you can also output
the signals via CANape. As with digital signals, this is either done manually, or
by a script command.

Manually setting analog outputs via CANape.

Create a calibration window (Fig. 7.24). In the dialog, select the relevant output
and click on Apply (Fig. 7.25).

;r\u‘ector CANape
File  Edit Device  Measurernent  Calibration  &nalysis Flash Tools Window ¢
A __?L‘;_-‘ reasurement windowws [ O% o s ? 1 4
’m Calibration windous ] Calibration windoaw
Symbol Ex Diagnostic windows 4 Group Calibration window
£ Al Other windows ] Pararneter Explorer
— Symboal Explorer Ctrl + EINGARE taps Curve window
lﬁ’ Pages 5 Hex window
[El Explare ]
TR Display elernents 4
- [ De Object names..,
1 Pa Warking point display »
- LA i Exterded 3

Fig. 7.24  Outputting analog signals
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Fig. 7.25 Specifying outputs for signal output

A window then appears, in which you can specify the output value (Fig. 7.26),
either by directly entering a value or by using the buttons on the top left of the
window. If the default increment is too high, simply enter a lower value, e.g. 0.1.

gl [2] Pararneter

- [ NIE ]3]0

$Pa[ams;sguT- [yianb s nh amee WETY TECRYS

Mame Valuerange: -10A Outl 10

Aoutl T

=[5 %

Fig. 7.26  Manually specifying the output value
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7.13 Displaying measured values graphically in the MX
Assistant (Scope)

The Scope tab in the Ribbon shows a diagram in the main window for display-
ing the signals. Set the measurement conditions using the Ribbon and specify
the display options. Select the signals to be displayed via the Signals tab in the
Scope window.
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Updating the firmware

8 Updating the firmware

Important

If you have older MX modules with firmware version 1.x or 2.x, you must install
the QuantumX Firmware Updater program from your system CD for Quan-
tumX/SomatXR, and first update to version 4.0. Only then can you use the MX
Assistant for further updates.

To update the firmware, use the File tab and the menu item Module -> Module
update in the MX Assistant. The menu item can be used to transfer a new firm-
ware version to several modules simultaneously.

Procedure

1. Download the latest files with the firmware updates from the HBM website:
http://www.hbm.com/Download. You can also use the dialog in Fig. 8.1 in
the MX Assistant to call the download site: HBM Downloads button.

2. Start the MX Assistant and use the File tab and the menu item Module ->
Module update to call the update dialog (Fig. 8.1).

3. In the Firmware package line, enter the directory containing the down-
loaded file.

4. In the Name column, click on the modules that are to be updated (& mark-
ing) or select All in Module selection, to update all the displayed modules.
Modules shown in green do not have to be updated, as they already include
the up-to-date firmware.

5. Click on Start update.
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.': Meodule update

Options

Open the firmware package (local), select the modules to be updated and start the update process.

Updating to an older version (red marker) will be done without further notice.
After the update all updated modules will be rebooted automatically.

with modules that already have the selected version (green marker) you can force to update again by using the appropriate option from the menu above.

' All downgrades

Firmware package -.- CUsershPublichDownloadsh4-3-1 hbg g HEM Downloads
X Mone 49 All upgrades
Module selection WAl P

Mame = Type  Seral/UUID Address Current firmware  New firmware  Task

Progress Error text
® @10 WA 0% | 0% 1
MX240  MXB40 ) 0% 0%
@ MX879 MX879 0035C5 192.168.100.127 42100 ﬁ 4.3.1.23006 0% 0%
@ Rescan network(s] [F5) O Flash module LED's “g Start update
@) Help

Fig. 8.1 The firmware update dialog

Cloze

The progress of the update is shown in the dialog (Progress column). A dialog
appears to indicate the successful conclusion of the update (Fig. 8.2). Other-
wise you need to read the error text in the column of the same name, to obtain

information about the cause of the error.

Update 22

@B Update finished [OK].
k.

Fig. 8.2  Dialog once the update is concluded
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Messages and information for error elimination

9 Messages and information for error elimination

9.1 Error messages when opening a project

Error message

Description

<Device name>: Error during
import settings from assistant!

The driver cannot import the configuration file (XML
file) exported from the MX Assistant.

This error occurs when a CANape project is opened
where no configuration has so far been implemented
with the Assistant.

<Device name>: Only one in-
stance allowed!

The QuantumX/SomatXR driver can only be integ-
rated (defined) once.

This error occurs when you try to define another
device that also uses the driver.

<Device name>: Could not find
MX Assistant 4! Please install
it!

The MX Assistant is not installed on the PC or can-
not be found.

Install the MX Assistant again.

9.2 Messages during a measurement

Message

Description

<Device name>: Error start
measurement. Devices are
not synchronized!

A measurement cannot be started as long as an MX
module is not synchronized.

Please note that the initial synchronization on an NTP
time server can take up to two hours. Synchronization
after a new start-up can take up to five minutes.

Error start measurement:
<Number> problems found
<DeviceUUID>: <Error mes-
sage> (<Error code>)

Measurement could not be started. The DeviceUUID
indicates the module in which the error(s) occurred,
the error message contains a text indicating the cause
of the error. The error code is only of interest for in-
ternal purposes or for HBM Support, see Section 10.
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10 Technical support

If any problems occur when working with the CANape driver, please contact
our Hotline.

E-mail support
Software@HBM.com

Telephone support
Telephone support is available on all working days from 09:00 to 16:00 (CET):
+49 6151 803-0

Fax support
+49 6151 803-9100

Firmware and software

The latest firmware and software can be found at
http://www.hbm.com/download.
Seminars

HBM also offers seminars in your company or at our training center. You can
learn everything there about measuring devices and HBM programs. You can
find further information at http://www.hbm.com in the "Seminars" section.

HBM on the Internet

http://www.hbm.com
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1 Sicherheitshinweise

BestimmungsgemaBe Verwendung

Der QuantumX-Treiber fur das Programm CANape darf ausschlie3lich mit
CANape in Verbindung mit Modulen der QuantumX- oder SomatXR-Familie
von HBM verwendet werden. Jeder dariiber hinausgehende Gebrauch gilt als
nicht bestimmungsgemaf.

Der QuantumX-Treiber stellt die Funktionen der QuantumX/SomatXR-Module
fur die Software CANape zur Verfigung. Die Bedienungsanleitungen der
Module enthalten die zu beachtenden Sicherheitshinweise fiir den Betrieb der
Module, die Sicherheitshinweise fiir CANape finden Sie in der zu diesem Pro-
gramm gehoérenden Dokumentation. Dariiber hinausgehende Sicherheitsmal3-
nahmen sind nicht notwendig.

4 A03325_04_X00_00 HBM: public QuantumX CANape



HBM Verwendete Kennzeichnungen

2 Verwendete Kennzeichnungen

Alle in diesem Dokument verwendeten Warenzeichen oder Marken weisen nur
auf das jeweilige Produkt oder den Inhaber des Warenzeichens oder der Marke
hin. HOTTINGER BALDWIN MESSTECH